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NVivo 10 and Chapter 5 – Getting Started
Incorporating Chapter 4 – Data preparation
In Chapter 5 to help get you started, we talk about productive things you can do in the early stages of setting up a ‘project’ in
software. Experimenting with these processes where relevant in your chosen software will help to become familiar with
useful entities which will help to manage your work and help in the analysis. We also incorporate here a certain amount of
information discussed in Chapter 4 about getting data ready for import into NVivo. See all coloured illustrations (from the
book) of software tasks and functions, numbered in chapter order.
Sections included in the chapter:
Creating the software project
Transparency
Getting organized
Importing data
Cross referencing
Literature management
A framework of memos

5.1. TYPES OF DATA ACCEPTABLE TO NVIVO
Text – NVivo 10 can manage files that are .txt, .rtf, .doc, .docx, and .pdf. It is fine to include embedded charts, tables,
graphs, or images,. However in Word files, headers and footers, page numbers, line numbering, comment boxes (as per
MSWord) will not be visible once imported.
PDF format - where the file has been converted into PDF from Word or similar application etc., the file can be imported as it
is, though some functions- like Text search will not work quite as well as if they were in Word/RTF/plain text. If the PDF
document was created (possibly scanned) without optical character recognition it may just be an image style format which
can still be imported but the more limited ‘region selection’ mode not ‘text’ mode will be required to apply codes or
annotations and text search tools are unlikely to work.
Datasets –Import e.g. survey data direct from Excel and other database formats.
Multimedia – NVivo 8 onwards recognizes many formats for visual, audio, and audiovisual materials. Most common formats
are useable. For video files, the general rule of thumb is that if they will play in Windows Media Player™, they will work in
NVivo.
Social media data (e.g. from Facebook, LinkedIn and Twitter) and Evernotes – can be imported into NVivo.
Ncapture – an interface between Internet Explorer and NVivo can be used to capture web pages, pre-code them and then
import them into a project
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5.2. TEXTUAL DATA PREPARATION
For semi structured and unstructured text.

5.2.1. UNSTRUCTURED TEXT
Unstructured free flowing prose is what it is, unless there are reasons for doing so (i.e. breaking it up or reducing it and then
adding headers which explain that) there is no point in going to any effort to change the way it looks. If you can get this in
Rich Text Format or in Word format, you can just import it as it is. In PDF format, you will not have a choice about changing
the way it looks!

5.2.2. SEMI-STRUCTURED TEXT
Included in these types will be e.g. most in-depth interviews, some focus groups (especially where speakers are not
successfully identified) and less structured field. Sentences are not identifiable by NVivo – but paragraphs are useful, see
below.

5.2.3. PARAGRAPHS ARE USEFUL STRUCTURES
If not bothering with the use of heading levels for structured data (e.g. Focus group data) – be sure to make use of useful
paragraph structures. This is because text search can be performed say on a word/content within a paragraph or for an
identifier (or an element of the identifier)- and the results Spread – to include the paragraph surrounding and coded.
Paragraphs are defined by Hard Returns (Keyboard/Enter – or forced line breaks - note that Shift/enter which is sometimes
used to separate text on to different lines does not create a paragraph break) …. see also the possibility of auto coding
speakers in focus group data or other structured data if Heading styles are used – see section below on
STRUCTURED DATA

5.2.4 PARAGRAPH STRUCTURE USED IN CASE B – FINANCIAL DOWNTURN STUDY
R-RP372- Yes…I was teacher - retired early due to health issues so I not sure I’m relevant. I suppose I do feel
that my pension has reduced in real value – but on the whole I feel a bit lucky that I retired when I did instead of
like my wife – she’s a bit younger – she’s now been caught by all sorts of changes - in the retirement age for
instance.
R-RP382- Now you say that – like you Jxxx – I’m quite glad I got out when I did – but that’s only with hindsight, in
one way it was the best thing that could have happened to me. OK it would have been nice to have been able to
top up my savings and pension with another 3 years of employment, but my finances are adequate…. I’m loving
retirement so actually my morale is very good. I shouldn’t really complain.

5.2.5 STRUCTURED DATA
i.e. with repeated questions or speaker identifiers (e.g. in a Focus group)
If data is genuinely structured with repeated headers or speaker identifiers which could usefully be autocoded – using the
relevant tool in NVivo. Consider using heading level styles in NVivo since the auto-coding tool can identify matching text at
matching heading levels across the data you choose to include in an autocoding exercise. In the example below the
(shortened) questions are repeated across all files. See Figure 5.1 below.
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Figure 5.1

5.2.6. CASE STUDY “A“ SAMPLE BELOW (Young People’s Attitudes to Sex Education)
– the interviews are not particularly structured but it was thought useful to apply similar heading structures (heading level 2)
to speaker identifiers (to enable easy auto coding) see the discussion in Chapter 4 about creating a node for each
speaker so that the interviewer or moderator’s text can be excluded in a text search or in later queries.

004-ENG-F-15
Missed the last bus, stay at his friend’s house and ring his parents, if his parents are able to pick him up, then pick him up or
stay at his friend’s house

INTERVIEWER
If he rings his parents how do you think they will react?

004-ENG-F-15
Well most parents will always react as if you did it on purpose, so you need to be a good actor, you need to sound really
upset, and you need to convince your parents that you’re really really sorry, that it won’t happen again
See Auto coding tool in Chapter 12 exercises.
TIP: ALWAYS CHOOSE NOT TO USE HEADING LEVEL 1 UNLESS YOU ARE ASBOLUTELY SURE THAT YOU
WILL NOT WISH TO USE OR INSERT A HIGHER LEVEL OF HEADING (e.g. TOPIC HEADERS) AT SOME
FUTURE STAGE OF DATA PROCESSING
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5.3 GET FAMILIAR WITH THE USER INTERFACE & FOLDERS
5.3.1 THE RIBBON TABS AND RIGHT BUTTON MENUS

Figure 5.2

Ribbon tabs provide access to varying functions.
Basic ribbon tabs consist of File - Saving, Managing etc, Home - editing functions etc., Create - making new things External
Data –various import options, Analyse - Coding, linking, annotating, Query - range of functions to vary queries and query
views and output, Explore - Charting, queries, models, Layout – manipulating tabular outputs, View – altering what you can
see, arrangement of windows, coding stripes etc.
There are a few aspects of work that are only accessible via the ribbon tabs (for instance some of the editing tools are only
accessible from the Home Tab, varying Code stripe views is only available from the View ribbon tabs, Charts and other
visualisations are only accessible via the Analyse ribbon tab). But there are many other functions which are accessible more
easily from the right button in the List panes.
Some ribbon tabs only open up when you are in a particular function, for instance when you are in a Model, a specialized
Model ribbon tab appears, but you create a new Model from the Explore Ribbon tab.

5.3.2. THE NAVIGATION PANE
The navigation pane (left hand portion of the screen) is the main way of moving around the main functional areas of the
software, Sources, Nodes etc – and getting Into the right folder you need in order to see the relevant ‘list’ so that you can
open individual items. When you select a function – a set of folders appears in the top half of the pane. Select a folder and
the relevant List appears on the right. Double click on an item in the list and the relevant item opens up in the Detail pane
below . Successive opened items are tabbed I along the central bar separating the List pane from the Detail pane.
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5.3.5. HOW TO CREATE NEW THINGS


You can either go to the Create Ribbon tab and use the various options there OR (and this is what we do
mostly…)



You can be in a function (via the Navigation bar) e.g. as illustrated below, in the Nodes function

Figure 5.4



Select the folder you want to be in and then –



e.g. right click in the List pane /New Node/ fill in details of the new nodes

5.3.6. FAMILIARIZE WITH THE SOURCES AREA
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Material inside any of the above sources can be classified, coded, linked, and annotated according to needs of the
researcher.
Memos can be linked to individual sources (1 per memo) – so that the memo related to a source can be opened at the
source or vice versa.
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5.3.7. CREATE FOLDERS TO HOUSE DATA
Using Case A – we illustrate a sample folder structure above; in a project consisting of different ypes of data we usually
recommend folders could be based on the type of data. This choice will vary depending on the complexity and variety of
types of data. If you only have Interview data for instance the project is longitudinal you might just make the folders based on
phases of data collection.
TIP: KEEP THE FOLDER STRUCTURE SIMPLE – ALTHOUGH YOU CAN SCOPE AND FILTER LATER QUERIES
BY FOLDER – FOLDERS CANNOT REFLECT ALL THE DIFFERENT FEATURES OF YOUR DATA. THE
ASSIGNATION OF ATTRIBUTES (VIA NODE CLASSIFICATIONS) WILL EVENTUALLY REFLECT THINGS LIKE
SOCIO DEMOGRAPHIC INFORMATION ABOUT YOUR DATA/RESPONDENTS/CASES ETC.


Right click at the top level (e.g. Internals) /New Folder – provide a name for your folder.

Continue with this process to continue to make second level folders from Internals.

Figure 5.5.

5.3.7 NODES – WHAT ARE THEY – WHAT PURPOSES DO THEY SERVE?
We cover this in Chapter 7 exercises.

5.4. IMPORTING DATA & BASIC HANDLING
There are different things enabled during the import of data. We begin to talk about these, but for now, the straightforward
importing of data, whether it is Text, PDF or the full range of audio-visual data – can follow essentially the same process.
You just have to be careful to tell the software what type of data you are looking for. See more below.
The import of survey data or social media data is more complicated. We recommend you follow the software’s help menu
guidance in those cases.

5.4.1. IMPORT SOURCES
Remember that ‘data’ and sources in NVivo is any material at all which will help you to integrate all the information which
feeds into your project. (See 5.6 for Importing multimedia data)
You can import using two options.
1. Just import data and do not worry about how you will organize data (with attributes or socio demographic variables)
2. You can build a structural framework prior to the imports – then take advantage of various things that the software
will do at the same time as the import to start the process of organizing the data – (using the creation of Nodes on
import and linking them to a ready made Node Classification).
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If we were teaching you face to face we would talk you through the second option (it needs explaining carefully and might be
better to take this on when you are feeling confident in moving around the software) So…because you might be using these
instructions on your own – and in the context of the range of ‘Getting Started’ exercises we recommend, we keep it simple –
just providing guidance for Option 1 above. (If you want to follow Option 2 see Chapter 12 Exercises where we follow this
through.)
Select the folder you want the imported file to go in


Either go via the External data Ribbon tab… or…right click in the List pane>Import >



Choose the correct media option e.g. Documents (or as in Figure 5.6 PDF’s) and find the file on your
computer.

Figure 5.6

5.4.2. EDITING DATA
Edit mode/Read only mode: note that it is always possible to make changes to textual documents once you’ve imported
them, but unless you change the default option, your files by default will be in protected Read only format when on display
in the Detail pane.
It will not be possible to edit PDF files.


To edit a source textual document see small Click to edit in bar immediately above the text in the detail pane.
Tools such as spell-check are not available in NVivo 10. It is always advisable to make use of word
processing tools in e.g. Word prior to importing data into NVivo. NOTE: IT IS MOST IMPORTANT that when
working in teams where NVivo project work has been done separately on different work stations (with the
eventual aim of merging work together in one large NVivo project) that data is never edited after import into
NVivo.

5.5. PLACES TO WRITE
One of the things we suggest you do in Chapter 5 is to think about the role of MEMOS in helping you manage your work in
the NVivo project. Also consider the role of LITERATURE and whether there are things you can do to optimize the project in
terms of helping to cross reference important literature with substantive data. Hence the data illustrated in Figure 5.6. above.
In Sources two other Folders in NVivo are relevant in terms of managing your analytic processes and ideas about literature
see Figure 5.7: Memos and Externals.

Please contact info@qdaservices.com if you intend to use these materials for teaching purposes. Visit the companion
website at https://study.sagepub.com/using-software-in-qualitative-research

This document is designed to complement your reading of Silver & Lewins 2014: Using Software in Qualitative Research: A
Step-by-Step Guide, Sage Publications, London rather than as a stand-alone resource.
Christina Silver, Ann Lewins & Jennifer Patashnick © SAGE Publications.

5.5.1 MAKE MEMOS
Memos are related to planning, tracking processes and thinking out loud about what is going on in your data. With that in
mind create a framework of memos.

OPTIONS


You can create folders to organize different aspects of note-making as illustrated in Figure 5.7



Or you can have the one predefine folder Memos, but within it name your memos carefully with standard
prefixes which tell you and others what type of memo it is – “PROCESS-…”, “THEORY…”



Create folders from the memos folder – Right click/New folder /name the folder as above



Create memos within your chosen folder by using the Create ribbon tab along the tab/choose the memo icon
- or alternatively as usual – you can select the correct folder and then right click in the List pane to create the
new memo



The new memo opens up in Edit mode so that you can begin work in it. If the memo closes, double click on
the memo in the list, it will re-open but you will have to ‘click to edit ’ in order to write in it

Figure 5.7

5.5.2 MAKING EXTERNALS
The Externals Folder - See Figure 5.7above Externals are places to make new files – space to write about data that you
cannot physically import into the software. As such they act as proxy files. This might be a good way to generate critical
appraisals of literature you are not going to access directly in NVivo (books, for example). This aspect is emphasized when a
bibliographic references data base (EndNote, RefWorks, Medeley etc) is imported in NVivo if there are no attached pdf files
– an empty External file is created in the Externals folder – named after the reference – and a critical appraisal can be
compiled here.


Create a New External by being in the Externals folder – right click in the list pane / New External



The dialogue boxes – see Figure 5.8 below allow you to add a title, description – to create a file link (if there
is one)
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Or simply fill spaces to denote location (top shelf?), structures (Units) in the files, Start range/End Range of
pages or chapters etc. The file will open in the detail pane

Figure 5.8

5.6. IMPORTING MULTI-MEDIA FILES
Importing video and sound files is much the same. Importing graphics/pictures is straightfoward.

5.6.1 IMPORT VIDEO


To import a video, audio or picture files you need to follow a similar process as described above concerning
the import of text (except you must choose to import ‘video’ not ‘documents’. Then simply click OK – see next
steps below and Figure 5.9

Note: If audio or video files are larger than 40MB
NVivo
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recommend

the

files

remain

‘not

embedded’ (see left). This means they are not
contained within the software project, but that NVivo
simply reads them. This is to avoid the project file
becoming too big. You need to be sure such files
remain

in

the

same

location

and

are

not

subsequently edited or NVivo will no longer be able
to read them.

Figure 5.9

If the media file is not supported – take the offer to go to the help menu to find out if you can resolve this.


If it is an audio or video file, you can then choose to play it from the tool bar buttons, the Media menu, by right
clicking, or hitting F7
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5.5.2. TRANSCRIBING AUDIO/VIDEO DATA WITHIN NVIVO
After you have imported your audio/video data you can transcribe your data inside NVivo 10.
See Picture 19 for illustrations of these instructions.


Open the video file you want to transcribe by double clicking on the video icon
The video should open automatically along with an audio wave. A new ribbon called ‘Media’ will appear.
This allows you to edit, analyse and control the video





Note that there are 3 Play mode icons – hover over each to see what they are each for: to summarise
o

Normal –will allow you to code the video

o

Transcribe - will allow you to create time-coded transcript alongside the video

o

Synchronise – allows the playback of video with transcript scrolling ‘in synch

To start transcribing you need to be in Transcription mode: start playing the video and hit F7 or the
Play/Pause icon when you are ready to transcribe; F7 will restart – when you have finished a segment of
transcribing – F8 or the Stop icon will complete that segment and assign a timespan. Starting play again will
create another row to transcribe into.
Transcription mode

Transcribing

Figure 5.10

Having imported data and begun to get organized in terms of memos as places to write, you can now experiment with the
types of exercises discussed in details in Chapter 6 – Working at data level – in order to get closely familiar with the data
themselves. See Chapter 6 exercises.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo 10 and Chapter 6 – Working at Data Level
Chapter 6 in the book is all about working at data-level. Being immersed in the data for most researchers is part of
familiarising with and analysing the data. You may need this before coding or to enrich and substantiate the coding process
(chaps 7-9). Remaining close to the data will be more important for some researchers, but for all, the functions covered here
may be key analytic processes in many different approaches to qualitative research. See all coloured illustrations (from the
book) of software tasks and functions, numbered in chapter order.
Sections included in the chapter:
Annotating
Marking data
Data reduction
Text searching
Word frequencies
Text mining
Hyperlinking

6.1. ANNOTATING DATA
Should you wish to use Annotations, doing so in NVivo works similarly to using Endnotes in a word processing application:
1. Open the Source you want to annotate.
2. Highlight the passage you wish to annotate
3. In Analyse ribbon tab – find the New Annotation button
4. This opens a numbered area at the bottom of the document where you can type a comment. After creating an
Annotation, that passage of text (referred to as the “anchor text”) will be highlighted in blue, reminding you that
there is an Annotation embedded at that point
Figure 6.1
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5. When you choose to Export coded data or a document – you have an option include annotations (which might be
embedded at any or the respective data). They will be flagged/numbered in the text and appear as numbered endnotes
6. Annotations you create across all Sources are listed together in the Collections area, under Annotations. Double
clicking on one of the list items will open the Source, take you directly to the annotated passage and show you the
content of the Annotation

DATA REDUCTON –DATA MARKING
In Chapter 6 we talk about the need to just familiarize with the data. In relation to the interview transcripts in Case A, Young
Peoples Perceptions, we needed to identify what appeared important discussion about family dynamics, early awareness
about sex(uality) and the importance of informal modes of learning. It was useful to mark data segments which threw-up
unexpected ideas that needed further attention.

Several tools for data reduction
ANNOTATING as above can be a process of marking data that is relevant for further attention. The notes made can be
relatively brief or non-existent – you could simply be using the device as method of being able to mark data – then
access quickly (see point 6 above and illustration at Figure 6.1) all the data that matters later (though, please note, you
have not ‘abandoned the rest of the data – but he relevant data is in full context).
EDITING – by changing the look of the data (Click to Edit) to focus attention (not recommend if working in a team)
CODING in simple ways can be a way of being able to retrieve just the data that matters – see Chapter Sections 7 in the
book and the relevant step by step sections.

WORD FREQUENCIES
To achieve a very quick overview of the physical content of a text file (or all or part of your textual dataset) a Word
Frequency query allows you to find the most frequently used words in your project. The queries below were scoped to only
the female speaker sections (we could do this since we had coded each speakers contributions to their own respective
nodes- see Chapters 6 and 12) but we could also just perform this query across all the data. In the long term we were
interested to compare across females and males.


Again,
select
where
you
want
the
annotations, or both – and in which sources (or selected items)



Then choose how many of the most frequent words to display. (Warning: the more words you display, the
longer the query takes to run.)



Experiment with the Finding Matches sliding scale – see how words are grouped (the example below shows
Exact i.e. a count of every word See Figure 6.3 A and in Figure 6.3 B using the Stemmed option below it has
identified words with similar endings and counted them together – see ‘Allowed’ in both lists)
You can also choose the length of word (in characters) you wish the query to consider



Because of the type of query result you receive with a Word Frequency Query, you have no option to save it,
as you do with other types of queries. If you do want to output it, R-click in the result Detail pane, and Export
List. The resultant table shows the most frequently used words, their length, how many times they appear,
and what percentage of the text they are in the selected sources

query

to

look

–
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Figure 6.2



Also Experiment with Side tabs (to right of results window) to visualize finds in different ways: Experiment
with the Cluster Analysis, TreeMap, and Tag cloud (see below) option in the side tabs. See Figures 6.3 A &
B … and Figure 6.4 below

Figure 6.3 A
Figure 6.3 B

Please contact info@qdaservices.com if you intend to use these materials for teaching purposes. Visit the companion
website at https://study.sagepub.com/using-software-in-qualitative-research

This document is designed to complement your reading of Silver & Lewins 2014: Using Software in Qualitative Research: A
Step-by-Step Guide, Sage Publications, London rather than as a stand-alone resource.
Christina Silver, Ann Lewins & Jennifer Patashnick © SAGE Publications.


The Tag cloud will show 100 most frequent words in an interactive graphic view and you can select the
colour option you want from an iconized set of colour-way options along the top. See Figure 6.4

Figure 6.4



The Cluster Analysis groups words in a dendogram according to their clustering in the data generally (be
patient this can take a while to produce)



The Treemap (not illustrated) creates a proportionate squared chart for each word (again 100 most frequent)



All items are interactive, click on one and the software produces a list of occurrences with 5 words of context
either side

TEXT SEARCHING
Text searching can be a way to focus on specific areas of talk. One of the aspects we were interested in exploring was how
the young people in Case study A related their concepts of risk in terms of getting pregnant with what they heard at school in
classes.

Text Search
You can run a Text Search looking for significant interesting words, acronyms etc. They might have been thrown up in a
Word Frequency query. A Text Search allows you to perform a more focused search of your textual data for content. For the
purpose of exploration of data early on we prefer to emphasize the usefulness of the Preview option rather than coding the
results, but you can do both one after the other – or you can code the results interactively while previewing. We cover the
preview options below.
1. Start a Text Search via the Query Ribbon tab (or via the Query Wizard –this option is not included below)


If you are only searching for one word or ‘string’ – as with the Word Frequency query you can vary the ‘match’
with the slider



If you are searching for various words at the same time to explore data around a wider topic area you can
impose a selection of words to look for. In this case the slider does not work. For example, you may search
for the root of a word e.g., ‘preg’ to collect variants of pregnant or pregancy, volunteer, volunteers, etc., or for
several words around a more general theme, e.g., volunteer, time, work, etc.
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2. In the Text Search Criteria tab, enter the word or string that you wish to search
3. Click on ‘Special’ to ask for more words using ‘AND’ or ‘OR’, or to use a wildcard. See Figure 6.5

Figure 6.5

4. Select ‘Text’ (or ‘Annotations’ or ‘Text and Annotations’) in the ‘Search in’ criteria depending on what exactly you’d
like searched
5. Select the Sources you want to include in your search (e.g., Interviews)
6. Switch to the Query Results tab and set the Results option to your liking. For the purpose of Exploration of data
early on we prefer to emphasize the usefulness of the Preview option rather than coding the results
7. Then press ‘Run’. See Figure 6.6. for the Resultant preview list summarizing the documents in which finds /’hits’
appear

Figure 6.6

8. If you skipped the Query Results tab, or if you left the default there as ‘Preview Only’, you will be presented with a
summary of your Text Search Results, as the picture above. Double clicking on a line in the preview results pane
with open the itme – and highlight hits in surrounding context
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9. Different presentations and visualisations are available by selecting a Side tabs tabs on the right side of the Detail
Pane (only available from the Preview results pane) Experiment with them all to see which format mIght be useful
to you. They provide different ways to focus

LINKING BETWEEN FILES OR PLACES IN FILES
This function uses a tool called See Also links. They can allow a reasonable level of connectivity between places in the
data but they do not naturally allow you to build a trail of multiple links in sequence. They really work best as a way to link
pairs of things. So if you were writing a commentary in a memo you could link that place in the memo to a bit of evidence in
the data. Or in the Case A the photo-elicitation vignette data you could build a link from the remarks of the respondents to an
area in the relevant photo.

See Also Links
1. We first show how See Also Links are a way to connect a part of a Source to another whole project item
2. We the show how to link part of a project item to another part of a project item (which is perhaps more in keeping
with the theme of working at data level)

6.5.1. LINKING FROM PART TO A WHOLE (FROM ONE SEGMENT TO ANOTHER
DOCUMENT?)


Open the Source / Highlight the selection to be linked – then go to Analyze ribbon tab as below and select the
New see Also link option

Figure 6.7



In the subsequent dialogue box Choose what item (document?) you would like to link to the previously
selected content



Two things happen, the original selected content appears with a pink highlight, and a footnote area appears
below to allow you to double click on it to open the linked file

6.5.2. LINKING FROM A SEGMENT TO ANOTHER SEGMENT
This time we start at the end-point.


Open BOTH Sources you wish to connect (if they are different Sources)



Highlight the selection you wish to be the end point of the link



Copy the selection (either R-click and copy or Ctrl+C)



Highlight the selection you wish to be the starting point of the link



R-click and “Paste as See Also Link”
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The original selected content appears with a pink highlight, and a footnote area appears below to allow you to
double click on it to open the linked file. The end point of the link will show no visual pink cue. (Hence, you
may wish to repeat the process going in the other direction so both starting and ending point are visually
marked.)

Note that though there are other convoluted ways of viewing connected items - double clicking on the associated Se Also
footnote is by far the quickest way to move between linked items bit sometimes, See Also (footnotes) are not on view. If they
are not on view – find the relevant option in the View Ribbon tab.
There are many other ways of vary visualisations while working at data level in NVivo but we have tried to cover the main
starting points.
Whereas not all qualitative researchers will work with coding devices (which follow in Chapter 7,8 and 9) We consider that
MOST researchers would find a use for the tools in the above sections since as we discuss in Chapter 6 of the book, they
provide methods of familiarising and aiding recall of significance in the data.
See Chapters 7,8 and 9 exercises which provide starting points for making use of coding tools and the management of
thematic work in data.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo 10 and Chapters 7 0 – Coding
Chapter 7 discusses coding, coding schemes and coded retrieval as key tools of qualitative analysis. We discuss the
terminology and philosophies which underpin coding processes. Specific methodologies use particular routines when
coding. More general thematic analyses or less code-based methods may use coding devices in ways which include data
reduction strategies, indexing and marking data. The structures of coding schemes, alternate groupings and basic retrieval
mechanisms are key to moving forward with analysis. See all coloured illustrations (from the book) of software tasks and
functions, numbered in chapter order.
Sections included in the chapters:
Inductive, deductive and abductive approaches
Theoretical coding
Grounded Theory
Visual data, coding directly or via a transcript
Retrieval
Filtering devices
Horizontal or Vertical cuts
Moving on
Quantitative overviews
Hierarchical and non-hierarchical coding schemes
How to escape the structures of your coding schemes

7.1 OVERVIEW – WHAT ARE ‘NODES’?
Nodes can be containers (like codes) which when they are applied to data enable retrieval or further organisation; they can
also be empty – for example they can act like hierarchical top-level codes with nodes underneath them which do contain or
have been applied to, data. The step by step sections here are mainly about the application of thematic or reflective nodes.

7.1.1. NODES – FOR REFLECTIVE PURPOSES
Nodes (in the former case above) are containers for or links to data exemplars based on, conceptual ideas, themes, codes
or more structurally (see below) for people, contexts, places etc. In this handout, the terms nodes, codes, keywords, and
themes are used similarly. Node is a term which refers to a point in the NVivo database but a code label may be the name
you give the node. Codes or nodes can be your ideas about the data – they can be generated inductively or deductively, and
may be refined, changed, grouped or deleted at any time. Applying nodes etc., to passages of source data at a minimum,
provides the basic code and retrieve actions needed to accumulate together, all the bits of data linked by common threads
and themes. The term ‘references’ in this context to be data sitting at or referenced by

Each Node of any sort can be linked directly to one memo – so that relevant analytic notes are easily accessible from
the node itself

Please contact info@qdaservices.com if you intend to use these materials for teaching purposes. Visit the companion
website at https://study.sagepub.com/using-software-in-qualitative-research

This document is designed to complement your reading of Silver & Lewins 2014: Using Software in Qualitative Research: A
Step-by-Step Guide, Sage Publications, London rather than as a stand-alone resource.
Christina Silver, Ann Lewins & Jennifer Patashnick © SAGE Publications.

7.1.2 NODES - FOR ORGANISATIONAL PURPOSES
These nodes (applied in the same ways as thematic nodes) facilitate interrogation across individual cases or categories of
respondent. You may additionally need to apply e.g socio-demographic information to whole data files - or to e.g. a speaker
within a focus group. In either case in NVivo each of those catchments of data need to be at their own node. Then to be
efficient those nodes should be linked to a Node Classification (which in turn enables socio-demographic information to be
applied). We describe this process in greater detail in Chapter 12 Exercises but see the Node folders below in Figure 7.1
which contain the structural nodes representing cases or respondents’ nodes for Case Study A, Young Peoples project –
(these nodes are linked to a Node Classification –not illustrated which allows attributes to be assigned, based on their age,
gender, nationality etc. The relevant node Classification for Case Study A is illustrated in Figure XXX in Chapter 12
exercises.
Do you have too much information i.e. complex facts, features and information to keep in your head when it will come to
interrogating and comparing across and within different files and cases? If so, see Chapter 12 in the book and the Chapter
12 exercise on Organizing data.

7.1.3 HIERARCHICAL STRUCTURES
TIP: WHEN STARTING OUT IT IS EASY TO CONFUSE FOLDER HIERARCHY WITH NODE HIERARCHY folders
are useful, but be sure you are creating nodes or sub nodes when you mean to be, not folders and sub
folders!

A STRUCTURAL FRAMEWORK FOR NODES
It is useful to begin to think of using Nodes Folders to separate different types of Nodes. We already created folders for data
in the Sources function to contribute to a useful structural framework.
HIERARCHIES OF NODES AND SUB CODES WILL APPEAR IN THE LIST PANE AND ARE A WAY OF
ORGANISING CODES.
NODE FOLDERS ARE UNDER THE MAIN Nodes FOLDER IN THE NAVIGATION PANE AND ARE ALSO WAYS TO
ORGANSE CODES – BUT ARE BETTER CONCEIVED AS WAYS TO SEPARATE DIFFERENT NODES WHICH
HAVE DIFFERENT PURPOSES OR ORIGINS e.g. CASE Nodes, THEMATIC nodes, AUTO codes. You can also use
the top “Nodes” level as a separate location and we sometimes use that area for thematic nodes – only using sub
folders for the clearly different nodes.
FOLDERS: for beginners we advise not to create more than 1 level of sub folders (this is where it is useful to be sure you
are clear that you are not confusing the need for sub folders with the need for sub-nodes)
NODE HIERARCHIES: if you need a bit more complexity in your node structure this is fine– a few more levels in the
hierarchical structures of Nodes themselves, say in the thematic node/code areas would be appropriate, but we would
suggest that more than 4 levels within the hierarchy of Nodes themselves is over complexifying the management of ideas. In
TEAM projects, there might be a decision to restrict to two levels of hierarchy for reasons of simplicity when sharing data
later.
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Figure 7.1

7.2 CREATING NODE FOLDERS… AND NODES
7.2.1 CREATING NODE FOLDERS
On the left of Figure 7.1 is the Nodes Folder (yellow folder icon) -(If thinking about a project with a mixed data set as in Case
Study A) create folders which allow you to store different nodes in different folders. Or... If you are just thinking about
thematic nodes, you can choose between putting all thematic nodes directly within the Nodes folder or as above create
different folders to differentiate between Early inductive and (later?) thematic nodes. Remember as discussed in Chapter
7 this project used a mixture of grounded (inductive coding) and theoretical codes which were generated from the
literature. The structures you create in Folders are up to you – but keep them simple. Don’t make life more difficult
for yourself. As we discuss in Chapter 9 – the way you structure a coding scheme often reflects the way you like to
work. An example of this is the way Ann Lewins puts all her thematic codes in the Nodes folder (she tidies up later)
– whereas Christina Silver – whose project this is – likes to do some up-front tidying up!
TIP: The great thing about folders in NVivo is that you can change your mind, restructure them and move or
drag nodes around between them whenever you like – really easily.

7.2.2 CREATING NODES – UP FRONT (a priori)


Click on the Node folder you want the node to be in



In Create Ribbon tab Click on New Node in the List pane, OR select an existing node and right click> new
node, OR R-click in the space of the List pane



Label the node/code add a description. (Although optional, defining your nodes is strongly recommended.) A
nickname is probably not necessary if you have named your node something brief



Colour? You can now colour your codes with a limited palette – Suggestion? certain types of code or
hierarchies should be related by colour. Colour can be used to filter what you see in the data later
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Consider the Aggregate option. (see more below)



Check the information in the List pane. Note the new node has appeared in the List pane. In the table
alongside, it codes no Sources and has no References to content yet, but this information will update as you
proceed with coding the data

7.2.3. MAKING HIERARCHICAL SUB-NODES


For a new top level code/node, follow any of the steps above but be sure you do not have any other code
selected in the List of nodes that you can see. NVivo terminology describes hierarchical nodes in terms of
their “familial” relation to each other, so a top level node would be a parent, and a node under that parent
would be a “child”



Successive layers of nodes can be viewed by hitting the plus sign next to a tree node to expand it. To hide the
hierarchy hit the minus sign next to the higher level node



Create a new child (or sub) node by R-clicking on the parent (top-level) node for the new child. If something
goes somewhere you didn’t expect, simply drag and drop it to where it ought to be. (Or cut and paste.)



Aggregation – Note that child nodes DO NOT automatically code to the parent node, and vice versa. If you
want something coded to both the child node and the parent node, choose the Aggregate option when you
create the node. You can also retrospectively aggregate a code. Aggregation collects from the next level
down. The aggregate option has to be checked on the parent (higher)code. In a hierarchy of e.g. 4 layers –
the aggregate option needs to be checked on 3 layers, then the very top node will collect the coding that
happens at all 4 layers



Configuring the table of information

7.3 Arranging the user interface to help you code
7.4.3. CUSTOMIZE THE VIEW WHILE CODING
Although the default arrangement for the interface is shown above, you can customize what appears and where (to some
extent) it is on your screen according to your needs and preferences. Experiment with the options on the View menu to find
what works best for you. The following customizations (not all from the View menu) in particular you may find useful:


Rearrange
the
List
and
Detail
appears on the right and the List pane on the left



In View tab>Detail View>choose the right option. This can be especially convenient when you are doing a lot
of coding



Resize panes Remember that all columns in the list can be resized so that the space allotted to the List pane
versus the Detail pane can be adjusted by grabbing the splitter bar line in between the areas you wish to
resize and dragging it of the View Ribbon tab options



Code stripe views There are several choices to be made about how you view codes in the margin area.–
note that when using NVivo 10 SP3 or later the code stripes display opens automatically ). Sometimes proactively varying the codes on display in the margin (against a specific selection of data) will remind you of the
presence or absence of particular concepts or topics you are currently focused upon

panes

such

that

the

Detail

TIP: ALWAYS use the Recently Used Nodes view, when in coding mode.
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Figure 7.2

7.4 CODING AT ALREADY CREATED NODES
Just as there are many ways to create and code to new nodes, there are multiple ways to code data at nodes you have
already created. You can also using some of these methods to select more than one code to apply to the selected passage
of data. We show 3 techniques – there are more!
TIP : ALWAYS use the View /Code Stripes> Recently Used Nodes view, when in coding mode

7.4.1. Technique 1 – Drag and drop


A favourite for many researchers, drag and drop coding allows you to drag a highlighted selection of data onto
any code showing in the List pane. This, of course, necessitates the list pane be showing Nodes (as opposed
to Sources or anything else from the Navigation pane)



Simply hold down left click of mouse and and drag it onto the desired node



IMPORTANT: One way to speed up drag and drop coding and see the most nodes possible on the screen at
one time is to rearrange the windows so that the List containing the nodes is on the left side, and the Detail
pane of the source is on the right side (as above)



Do this by going to View Ribbon tab /Detail View /Right



Then arrange vertical splitter bars to accommodate as much text on the right as possible while seeing
enough of the code labels on the left
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7.4.2 Technique 2 – Right click over selected data


Select text – Right click over text > Code at Existing Nodes/ navigate around Nodes /codes system
hierarchies to find the codes that are relevant and check the relevant boxes alongside -/click OK

7.4.3. Technique 3 – Using Quick Coding bar at the base

Figure 7.3



get into the right folder) if you have made sub folders for instance.

Figure 7.3

Figure 7.4



Select the data you wish to code first.



along the Quick coding bar at the base of the detail pane Click on the Select Location icon ... on the first
(three dots) icon on the middle left of the bar at base of detail pane



The new node will go into the Nodes folder by default if you do not change the selection at the first … icon



Select the second … icon – opens the Select Project Items pane



Single click the folder in which the nodes you’re interested reside
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Then, ‘tick’ or ‘check’ the node(s) you wish to use for the data you have highlighted



Once you have checked the relevant nodes (navigate around the hierarchies by clicking on plus + signs)
Click OK



VERY IMPORTANT: Lastly, on the Coding bar, be sure to hit the green checkmark towards the righthand
edge of the quick coding bar to confirm the action. The previous steps might not accomplish anything
without this!

7.5. CREATE NEW GROUNDED CODES
These are nodes which are created and attached to selected data in one operation


Using the same Quick Coding Bar above in Figure 7.4. – allows you to create a new (inductive? grounded? )
code by overtyping or filling in the Code At bar towards the right hand side of the bottom ‘quick coding’ bar.
Be sure to hit the green checkmark to confirm the action.



See above in Figure 7.3– after selecting text you have the option to right click > Code Selection at New
node – here again you will find it by default will put the new node straight under the Nodes folder unless you
hit the Select button to choose EITHER another folder OR a node to hand your new node from

OR

Figure 7.5

There are more ways to code – for instance there is a recently used list of codes available and selectable from the bottom
Code-at (Quick Coding) bar. Experiment to come up with a way that best supports your preferred way to work.
There are also Uncoding actions which are possible (see Red Cross icon) and next exercises.
Remember – any coding initiated in the Quick Coding bar – needs to be confirmed by hitting the green check
(tick) icon along towards the bottom right of the bar.

7.6 EXPLORE RELATIONSHIP NODES
See the online Help menu in NVivo to explore how it is possible to identify connections between nodes, to then join 2 nodes
together with your defined relationships, then assign the new complex node to data where the relationship holds true. Not a
vital process and one you may not have time for, but it provides an extra dimension in coding data and is exclusive to NVivo.
Chapter 8 in the book discusses the immediate results of coding processes –i.e. the ability to retrieve all that coded data
along particular lines and then to enhance and focus retrieval - to filter – manipulate- recode – export . See next exercises in
the section related to Chapter 8.
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7.7. MULTIMEDIA FILES – FURTHER BASIC HANDLING IN NVIVO
This section is necessarily brief but provides basic familiarisation with some useful data handling, annotation and coding
devices for multi-media (note that for sound only the devices are similar to those illustrating video). Mostly, other sample
data is used in the illustrations.

7.7.1 GRAPHICS/PICTURES - MAKING LINKED NOTES AND CODING

Figure 7.6



With the picture on view, click to edit.



Make a selection within the graphic/right click/ Insert a row – and write notes.



Make a selection/right click /Code selection.



Code the notes instead

Either

or

or

7.7.2. CODING AUDIO/VIDEO DATA
Coding multimedia data is very similar to coding textual data. For either audio or video sources, you can select transcript text
and code per usual, or you can select a segment on the progress bar and code that directly as if you’d highlighted text.
See also basic transcription multimedia pages Section 5.5.2. The difference is not in how the coding works, but how
passages are selected and how coding stripes are displayed.


To select a passage – (see Exercise4, F7 to start play, F7 to pause, F8 to stop – or see Play Back area in
Media Ribbon tab). Once play has started hit F11 function key to start the selection, Hit F12 to finish the
selection



To code the passage – right click over the blue rectangle now showing along the Progress bar. Code as you
would text (see coding exercises 7.D. and 7.E.)



You can also code the transcript, as you would text
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If synchronous transcripts or notes (i.e. the text were coded), coding stripes appear solidly alongside the
transcript, and “shadow coding”, analogous to the solid coding stripe, will appear alongside the video progress
bar. (Or vice versa if coding has been done on the play bar) Shadow coding looks like coding stripes with
hatch marks which give it a slightly lighter colored look. Any annotations and links (more on these later) will
appear above the progress bar as light blue (annotations) or reddish (links) coding stripes

Figure 7.7

You have been coding in order to make collections of segments of data along particular topic and concept based lines of
discovery and enquiry. See next the exercises about retrieval of those topic based collections in the section related to
Chapter 8.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVIVO and Chapter 8 – Coded Retrieval
Chapter 8 in the book focuses on retrieval – a crucial aspect of qualitatively coding data. Yet there are many aspects of this
which lead to other things. While looking at one batch of coded data you may want to delve deeper and recode it. There is
an aspect of interrogation, using filters to examine particular catchments or subsets of data, cutting data in different ways –
vertically in one document or horizontally across all.
Sections included in Chapter 8
Continuity
Horizontal and Vertical cuts
Filtering devices
Recoding
Generating reports
Quantitative overviews

8.1 RETRIEVAL – VIEWING CODED DATA


If you need to look vertically through one file at a time, reviewing what you have done open a document and
ensure Select Coding stripes /All has been selected – this way, you will see any codes appearing in the data.
Though this is not so easy since all codes may occupy a very wide margin space and require much scrolling.
Or you can selectively review codes



Once you have done some coding, you may want to review the passages you have selected for a particular
node. To do so, double click on the code you want in the List pane. This will open the code in the Detail pane.
Each source that has references to the chosen code is listed, headed by a hyperlink back to the source

Figure 8.1

The tabs down the side provide different ways to view the references, and are dependent on the type of data media coded
there – e.g. a side tab for video would be apparent if video had been coded at ths node.
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ANALYSIS COMMENT: There are many reasons why you may wish to see what coding you’ve done, or what
content is coded at a node. You may want to review your coding, to compare each passage with the other
passages, or to compare with a colleague’s coding (more later on teamwork), or by means of showing Coding
stripes to browse what else is coded in this source at that node, or simply to get back to coding where you left
off.

8.2. MANIPULATING & PROCESSING RETRIEVAL
Remember that when you are retrieving coded data you are looking horizontally, one code at a time across the whole data
set. See Multimedia retrieval below at Section 8.3

8.2.1 CODING-ON OR RECODING
Coding in this window is exactly the same as all the options at your disposal in Chapter 7 sections. Any new coding you do
to these coded catchments of data – go to the original document

8.2.2. VIEWING MORE CONTEXT


It may be useful to be able to see the surrounding context of a coding reference you’re examining. This can
be done in several ways:



You can jump to the source by R-clicking on the passage > Open Referenced Source. This will take you to
the source and highlight the passage in which you were interested.



You can view additional content surrounding your passage of interest without going back to the whole source
by R-clicking on the passage > Coding Context > and choosing how much you wish to see.

Figure 8.2

This will bring in your selected quantity in light grey type so you can differentiate it from what’s actually coded at that node at
which point you can select more of it to code into that node if you would like.

8.2.2 INCREASING THE AMOUNT OF DATA IN A REFERENCE
If you find that you want to increase the amount of data that a reference contains, highlight the full amount you want and
code it per usual. NVivo will combine your previous selection and the new selection into a single reference.
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8.2.3. MORE ON CODING STRIPES – WHAT THEY ENABLE
Another way to view what you’ve coded is to use coding stripes. View coding stripes when looking at coded data or when
looking at full documents or multimedia files


Turn on stripes by View Ribbon tab >Coding stripes



Usually choose the Nodes Recently Coding option when actually coding



To choose which codes you see with stripes in the margin, choose to Select Items… Then you can check off
which stripes will appear



Otherwise, try the other options to see Nodes Most Coding, Nodes Least Coding, Nodes Recently Coding, or
Coding Density Only

Figure 8.3



For the Most Recent, Most or Least Coding options, 7 codes only are displayed, but this can be varied at the
Number of stripes option



Coding Density is a grayscale stripe that will appear with varying shading indicating the number of nodes
coding a particular passage. Hover over the stripe to see the names of what nodes are coded there



If there are nodes not showing that you want to see at a particular point, R-click over the Density stripe in that
place > Show stripe > chose the code







Figure 8.4
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Uncode a passage by right clicking on a coloured code stripe>Uncode. This breaks the link between that
code and that point in the data



Use colours assigned when creating codes – View Ribbon tab> change Colour Scheme>Item colours

EDITING NOTE: Having coding stripes showing will make your source Read Only, regardless of whether you
previously had the Click to edit option checked.
Also when retrieving coded data in the detail pane you cannot edit the data

8.2.4. REMOVING A CODE FROM DATA


While you are reviewing coded data, you can remove the code you are viewing from part or whole of a
passage by selecting the required bit of text right click and select the Uncode selection> Uncode selection
at this node. Quite important to be conscious that you have selected the right one of those 3 uncoding
options that appear



OR a quicker option – Select the bit of data to be uncoded and hit Ctrl F3

8.2.5. EXPORT CODED DATA
There are extensive ways to output data material about your data to other formats and applications. Not all ways are
included in this handout since there are infinite combinations of settings required for different reasons which will be based on
your own particular requirements.

EXPORTING VIA THE LIST PANE
This is the general and usually used qualitative form of output which can be achieved almost anywhere in the package by
different methods. This would usually be what is required for e.g. coded output and is easier to generate than the more
formal Reporting functions below.


In List pane – select the item/s you want to export content for, say a Node or a Document, Right click > Export



IMPORTANT: If you accept the default Entire Content an html file will be created

Figure 8.5
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If you want a Word file or files to be created click on down arrow and select Reference View



Check any of the additional options carefully e.g. always check the Name option, this will insert the name of
the item in the content itself;



If you use the Annotations tool, always check that option



If you are uncertain about where the file will go, pay special attention to the File saving window which opens
to allow you to create a new folder or to locate the file usefully



Similarly check the Open on Export option so that you can see the editable file/s you have generated on
screen before closing them down

8.2.6. PRINTING
Sources, Nodes, Models etc can be selected in a List Pane and printed from the right click menu.

8.2.7. REPORTS
The formalized Reports and associated Extracts function (in Navigation bar or Explore/Ribbon group) as in NVivo 10
specifically concerns the support provided for mixed qual/quant methods. Some of the reports only provide quantitative
information or summaries. Experiment with these via the Help? Menu.
Two standardized Reports will also provide e.g. qualitative coded source data.
1. Coding Summary Report by Node
2. Coding Summary Report by Source
These reports are essentially the same but allow for different sorting mechanisms. This would be a quick way to export many
codes at once. Experiment with all the drop-down options and Select buttons.

Figure 8.6

3. Extracts (filtered summaries of data) can be created (Explore ribbon tab) which can also include coded text
The next sections follow through on ideas raised in Chapter 9 about the coding scheme and how alternative groupings and
manipulations of codes can help you move on in the analysis. Either go to multimedia sections below or see next exercises.
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8.3. EXTRA SECTIONS ON MULTIMEDIA RETRIEVAL
8.3.1 RETRIEVAL OF CODED AUDIO/VIDEO DATA


Double click on a thematic node as usual – here “Incentives”



In the side tabs – you will see a number of tabs



Select the Video tab- and all the coded video files will be iconised along the top (only one in the view below).
If there is more than one you can click on the video file icon of your choice



The coded passages along the play/progress bar are in white. If you hit Play or F7 only the coded segments
will play back



When outputting you can really only output to html format of you want to be able to play back the segments
outside NVivo. right click on the node/Export node/Entire content (i.e the default option – an html file will be
created)

Figure 8.7

8.3.2. OUTPUT OF CODED VIDEO/SOUND etc.
The nearest form of coded output i.e. getting the coded clips outside the software – is to Export the Entire content (but only
play the coded clips) in html format. It is not possible to create a new file containing just coded clips. This would require
video editing software inside NVivo and the capability is rarely found in CAQDAS packages.


Find the node you want to export, right click > Export> Export Node> Entire Content. Ensure you include
annotations if you have used that tool to add insights

The next sections follow through on ideas raised in Chapter 9 about the coding scheme and how alternative groupings and
manipulations of codes can help you move on in the analysis. See next exercises.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo and Chapter 9 – Working with Coding Schemes
Chapter 9 discusses how the structures of coding schemes, alternate groupings are key to moving forward with analysis.
The nature and structures of the coding scheme in a software application and how it can be used can make a difference to
the processes of analysis. There are two key aspects - in order to feel confident about the potential of a software to support
particular working styles the inherent nature of the structures is significant; following on from that the ability to manipulate the
coding scheme and extract the most from it will increase confidence in the software.
Sections included in this chapter in the book
Project related factors
Is ‘coding scheme’ the same as ‘theoretical framework’?
Separating aspects of analysis
Escaping the confines of a scheme
Hierarchical
Non hierarchical
Better ways to collate or express theory
Sets and alternative grouping
Features and additional functions related to the coding scheme can be used in many ways to support interpretive progress.
In Case study A, Young people’s project – folders were used to separate parts of the coding scheme, node hierarchies
helped to organize theoretical nodes, and Sets helped to collate ideas and collect nodes and items in different ways.

9.1. HOUSEKEEPING THE CODING SCHEME
RENAMING A NODE
To rename the node, either select and then single click the title of it in the List pane and then rename it, or R-click and go to
Node Properties where you can also rename it.

DEFINING/DESCRIBING A NODE
If you did not define the node when you created it, you may wish to go back and add a definition later on, or to view or edit a
definition that currently exists. R-click on the node in the List pane and go to Properties. You can then type into the
Description window.

DELETING A NODE
Sometimes, you may find that a node that exists in your project is no longer necessary and you wish to remove it entirely
from your project. Simply select the node in List pane and hit delete key. Note that this will remove it from the ENTIRE
project, not just at one specific location. (See also 7.8.3. Uncode a node in coding stripes view)
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TIP: You may find it a safer strategy to never delete nodes from your project. Instead, consider moving them
into a tree node which you can generally ignore called “Deleted Nodes”. (See below for moving codes
between free and tree nodes.) That way if you later change your mind, your node still exists!

9.2 RATIONALIZING – CHANGING THE CODING SCHEME
9.2.1 MOVING CODES AROUND IN THE NODES STRUCTURE


Nodes and their accompanying references can easily be moved back and forth between hierarchies



To do this, R-click a node you wish to move > Cut > navigate to where you wish it to be - If you want it to be
under another node – select that node first > R-click > Paste



If you want the moved node to be on its own at the top level of the nodes – after you have cut it –
ensure no other node is selected – find a space at the bottom of the list of nodes and paste



We recommend to ‘cut’ the node when you move it rather than ‘copy’, because you don’t want to
accidentally leave multiple versions of nodes which look alike – but are actually seen by NVivo as
completely different. This can lead to possible uncertainties, messy coding schemes and at worst,
erratic coding processes

9.2.2. MERGING CODES/NODES
Sometimes you will find that two nodes which started out as distinct in your project are really coding the same thing.


To combine them into a single node, choose the one you wish to “disappear” > R-click it > Cut or Copy >
choose the one you wish to merge into > R-click > Merge Into Selected Node

CAUTION: It is very difficult to separate the nodes again (unless you UNDO very quickly) – so this is one
occasion that you might preferably choose the Copy option and only when you are ready – delete the old node
taking care not to code to it in the interim.

9.2.3. CREATING THEMES, HIGHER CONCEPTS
Sometimes the merging of codes is a subtly different analytic task specifically to do with the creation of themes or higher
concepts. You need to make a decision as to whether the individual nodes need to be kept as well so that you can work at
either level – the higher concept or the detail


To do this - select all the node/codes which contribute to a concept – right click/ Create As> Create as Node
see Figure 9.1 This leaves the original nodes in place

Another way to achieve a half way house while considering the merging or to group the same codes together is to
alternatively group short cuts to these nodes in a Set – see below.

Figure 9.1
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9.2.4. ABOUT SETS
The ability to create alternative ways to group codes beyond the coding scheme allows the user to think creatively outside its
formal structures but not to lose the ‘order’ you have created there.
Sets exist in the Collections part of the Navigation Pane. Because Sets are groups of shortcuts to project items, e.g. nodes
and sources, they enable you to cut across the basic structures for alternative, perhaps temporary reasons. As such, they
may offer a good alternative to extensive reorganization of the coding scheme(without actually changing the main codes
listing) See Figure 9.1

IDEAS ABOUT SETS


Sets provide ways of ‘moving on’ by gathering codes/Nodes together to theorize. This is a good way to enable
one Node to contribute to several theories: include it in several Sets



A useful Set to have is “Things I Want to Talk About at Our Next Meeting”. In there, put your project log
Memo, and any Nodes and Sources you want to discuss



Sets can also be used to aid teamwork if different people are analyzing different Sources. Create a Set for
each team member and add the Sources respectively



Sets can be created to narrow down a long list of Nodes to only the relevant ones for a particular research
question or developing theory



Sets are just collections of shortcuts – you can add and delete items from a Set without harming your project
as a whole



You can generate a set from a query (sometimes more appropriate than coding the results)



You can visualize e.g. the nodes and sources in a set in a model

PROPERTIES OF SETS


Sets which are created by hand – are generally dynamic (i.e. self-updating)– the codes FOR instance in them
reflect what is going on outside the set – as does any source file within a set



An outcome of a query can be to create a Set. Sets which are created as a result of queries are sets of
source files – these sets are not dynamic since they rely on combinations of things which may only be correct
at the time of the query. For instance you may have changed attribute values which were a constituent part of
the original query – this aspect of the set is not dynamic
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9.2.5. CREATE & POPULATE A SET


Go to the Collections area in the Navigation Pane / R-click on the Sets folder and choose ‘New Set’ / Give
the Set a name It will appear hanging under the Sets folder to the left.

Figure 9.2



R-click on the Set and choose ‘Add Set Members’ > Navigate through the Select Project Items dialogue to
find the codes (or other items) required > Click OK



Add items to a Set from other items’ List Panes, too. Choose the item(s) you’d like, R-click over them, and
choose to ‘Add to Set’, or create a new Set from them



Figure 9.2 above illustrates that Sets can be generated for a range of practical, theoretical, and analytical
purposes. In this example, different types of Sets have been prefixed to order them logically. The Set “WRITE
– Thesis Chapter 4” which is shown here contains the shortcuts to project items of different types: codes,
primary data, literature files, and Memos. It is being used to gather together all the materials required to write
that chapter

Chapter 9 in the book is closely related to the idea that what you have done so far can be manipulated in terms of regrouping to help you move towards analytic concepts and explanations. Sets for instance can be created at any time and
need not initially contain anything; they may simply be ‘pointers’ to areas of interest or reminders of aspects which need
consideration but as they fill up with items which are relevant they are helping you to stay focused, to experiment and to
write-up. So the coding scheme features as much as what follows in Chapters 10, 11 and 13 to support the ability to develop
your interpretation. See Chapter 10 in the book and the following exercises about managing those interpretations.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo and Chapter 10 – Managing Interpretations
Chapter 10 in the book is all about managing interpretations; managing where and how you make analytic notes, using
software structures to ensure your thoughts do not get forgotten or your notes lost. Ways of expressing or visualizing
connections and relationships are sometimes provided in software and help in the generation and management of the ideas
that you have about the data. The literature that informs your work is very important and these software programs can be
used in many different ways to manage cross referencing with substantive data or to manage the literature review itself.
Sections included in the chapter:
Writing as continuous analysis
Critical Appraisals of literature
Analytic memos
Process memos
Definitions
Linking notes to data
Integrating notes with other work
Visualising memos

AUTHORS’ CAUTIONS REGARDING LITERATURE MANAGEMENT TOOLS IN
NVIVO
NVivo encompasses a wide range of tools to help you manage literature. It is useful to have an overview so that you get a
sense of how different areas in the software might fit together in a manageable way to support iterative, interpretive
processes generally (and to see how they also might help with managing a literature review). However it is the ‘fitting
together’ of all the tools offered for literature review management which itself might be problematic. We cannot solve those
issues for you. We provide ideas and principles but limited step by step. We try to keep things simple. If you do experiment
with every tool try to evolve a judgement about how a selection of them will fit together for you. There is much step by step
information in the previous Chapter based exercises which will have relevance here.
Given the extensive support for specifically, managing literature in NVivo the export/ import possibilities between many
bibliographic software packages and NVivo requires almost tailored support for each researcher’s own circumstances. Work
requires careful individual experimentation, management and clear use of extra procedures to avoid duplication and overcomplication. Look to the online help menu in NVivo for further step by step support.
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10.1 THE RANGE OF TOOLS
To support interpretation, analytic and procedural writing TO SUPPORT INTERPRETATION, ANALYTIC AND
PROCEDURAL WRITING AND REFERENCING LITERATURE

10.1.1 GENERAL TOOLS OF USE FOR ALL TYPES OF WORK


Memos - see more below at 10.2



Memo links – see exercise at 6.5



Annotations – notes anchored to data segments and listed as hyperlinks centrally see exercise 6.1



Externals in the Sources area, or proxy files representing entities or files you want to write about but
physically cannot or do not want to import. See more below at 10.3



Coding – codes can be used to manage thoughts about literature fils, just as they can support work with
primary data – see Chapter 7 exercises



Hyperlink tools within normal writing spaces – make hyperlinks to outside files or web pages. See below



Import web

pages

using

NCapture

–

add

on

tool

in

Internet

Explorer see

more

below

10.1.2 SPECIFICALLY TOOLS TO MANAGE LITERATURE


Import the bibliographies from specific collections (just a list of references) – then code them to cross
reference with substantive themes, annotate them



Import full literature files, pdfs etc into NVivo – normal imports – do all the things to them that you might
do with primary data, code them, annotate, link memos to passages within them, search them (with
restrictions on the handling of results from text searches)



Import the collections or libraries into NVivo – from the reference management tools i.e. database
exports and variably, accompanying pdfs



Hyperlink tools within normal writing spaces



Externals (special files in the Sources/Externals folder)



Memos to link to full files outside

10.2 MORE ON MEMOS
We talked fully about the step by step creation of memos in the Chapter 5 exercises when getting started with the software
project.


Get some ideas of how different types and organisation of memos can support the process of research and
analysis in Figure 10.1 below – oriented to case A, Young Peoples Perceptions project



Create memo spaces as here, to write about individual research questions, chapters (including the Literature
Review chapter), Policy recommendations etc. Be in the required folder , Create ribbon tab /New memo OR
right click in the List pane/New memo
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Figure 10.1

10. 3 MORE ON EXTERNALS
The Externals Folder is useful if you want to reference relevant materials which you cannot or do not want to incorporate
directly into your NVivo project.


When a bibliographic database is imported (e.g. from Mendeley, EndNote, Zotero or RefWorks etc., via the
export of an RIS or XML file ) if an attached pdf is not also imported automatically, a blank External file (and
possibly also optionally, a memo) is created in the Externals folder –for further work to occur



Pro-actively create externals - be in the folder you need to be in if you have created multiple folders under
Sources/Externals then Create ribbon tab /External) (they can Include books, films, television programs, or
even a room, a building or an area!) In this folder, you will create initially empty ‘proxy’ Sources which
represent the externally held material (NOTE: YOU CANNOT IMPORT READY MADE FILES INTO THIS
FOLDER- THOUGH EVENTUALLY YOU CAN WRITE, OR COPY AND PASTE OTHER READY MADE
MATERIAL INTO IT). See dialogue box below at Figure 10.2



A new blank space (or with numbered units if you chose to make them) W rite notes or summarize the
material, and those notes can be treated as data within NVivo (e.g., be coded, searched, etc.)



Also link to e-books, large amounts of video data, or any other material or entity that might be of interest for
your project



Where possible, i.e. when you make a File path connection in the initial dialogue box, NVivo creates a
hyperlink from within the project to the externally held file or website…



When opening the external file, (if the file path has been designated at creation) you will either choose to
open the (proxy) external file (inside NVivo) or the actual file (outside NVivo) (!!)

TIP: in the current version, once you have arranged the properties of the External, see above Figure 10.2 – it is
not possible to change them e.g. the Contents, Units, the Start range – so give them some careful thought
before deciding on them.
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Figure 10.2

10.4. MORE ON IMPORTING BIBLIOGRAPHIC MATERIAL
10.4.1 GENERATE THE BIBLIOGRAPHY (LIST OF LITERATURE)


Compile ‘by hand’ in an ad hoc way – inside or outside NVivo



Use a Reference managing software then export the Bibliography from the Reference managing software



Work out how to export the bibliographies from the reference software and include the notes you have
created attached to each reference. Sometimes it is not so easy. Of course it will depend on how you have
used the reference software. You may not have made ‘notes’



If you can at least import the bibliographic list – e.g. below – you can then add abstract information or notes
about each reference as the references are read and assimilated



Once the list has been imported into NVivo (just as a normal Internal Source) via the Document Import option
– this becomes a normal file that can have anything (within reason) done to it!

10.4.2 IMPORT COLLECTIONS OR LIBRARIES INTO NVIVO FROM REFWORKS /
ZOTERO / ENDNOTE
These processes are complicated slightly by the fact that at both ends – the bibliographic software and the NVivo software
are updating at dIfferent rates. You may find incompatibilities depending on what the current status is in either location.
Some general outcomes follow:
Individual libraries or references can be exported from each of EndNote, Mendeley, Zotero, RefWorks (there maybe others
by now).

THREE POSSIBLE OUTCOMES
It is very important that you get these options and their implications clear – the outcomes depend on successful working and
exporting choices in the bibliographic software, the current status regarding updates in either software and the right options
(to fit with all those chosen in the import dialogue box in NVivo see Figure below)
a You might be importing references form the above applications – together with all the information about them – which
will be used as classifications /attributes but importantly, will include no content apart from the abstract. External files will
be created for each – in which you can write or paste useful material. . Together with each import a memo is created (but
only if there were associated Notes, Abstracts etc at the relevant reference). You can choose whether to let the software
‘organize’ the memo in the same way as the External i.e. at the Reference(?) Classifications .
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b Independently of the above reference managing softwares, you might have already imported full text pdf’s into your
NVivo project having found them while browsing the internet or having stored them on your computer in the past – but
you have no publication/bibliographic information e.g. at Classifications in NVivo. If you have that information in your
reference managing application (with or without attached pdf) – you can import it – and assign the accompanying
information to the existing file inside NVivo.
c In your collection or library you may be storing attached full text pdfs with some references. If the right options are
chosen at import into NVivo the full text pdf will be placed in Internals folder, and if the right steps have been followed
before hand, the relevant Source classification attributes will be assigned to the pdf. (References which do not have full
pdfs attached will be treated as at b. above).

Figure 10.3

Follow the steps in the NVivo online help menu to get more specific step by step advice for your particular situation and
bibliographic software.

10.5 MORE ON CAPTURING WEB MATERIAL
A growing variety of web content and social media is available to you using NCapture, a web browser extension, icon seen
left, which is available for free with NVivo.- see online Help menu in NVivo). It allows you to capture and import a screenshot
of any webpage as a PDF or various social media sites (such as Twitter, Facebook, and LinkedIn) as a dataset (table). Once
you have NCapture installed (see the Help Menu for instructions), open your browser, and navigate to the website of
interest.

10.5.1 FIRST CAPTURE THE WEBPAGE
1. Click the NCapture icon in your browser bar
2. A dialogue box opens (right)
3. Choose your source type (probably ‘Web Page as

Please contact info@qdaservices.com if you intend to use these materials for teaching purposes. Visit the companion
website at https://study.sagepub.com/using-software-in-qualitative-research

This document is designed to complement your reading of Silver & Lewins 2014: Using Software in Qualitative Research: A
Step-by-Step Guide, Sage Publications, London rather than as a stand-alone resource.
Christina Silver, Ann Lewins & Jennifer Patashnick © SAGE Publications.
4. PDF’), source name, optional description, memo nodes, etc.
5. Click Capture
6. See NCapture Progress page below
NOTE: WEB PAGES ARE CAPTURED USING THE PDF OPTION ILLUSTRATED BELOW AT FIGIRE 10.4 –
SOCIAL MEDIA WOULD BE CAPTURED USING THE DATASET OPTION (NOT COVERED HERE).

Figure 10.4

10.5.2 IMPORTING A CAPTURED WEB PAGE FROM NCAPTURE

Figure 10.5

1. As in Figure 10.5 above, go to the Sources section of the Navigation pane > Internals > Web Content subfolder (or
wherever you’d like the new Sources to be created)
2. Go to the External Data Ribbon tab > From Other Sources > From NCapture (as seen left)
3. A dialogue box opens, as seen below , showing recent captures. Choose the captures you’d like, and click Import.
Webpages will be brought in as .pdfs; social media files as tables, depending on your choices during capture
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Figure 10.6

What we have covered in these sections raises new ideas for incorporating different types of information and reminds of
standard tools which help to manage ideas. Related to these in the fuller discussion in Chapter 11 of the book are mapping
tools which help to visualize connections in a graphic sense. See starting points for using graphic mapping tools covered in
Chapter 11 exercises.
See also Chapter 12 for other visualisations ‘map’ the data from different traditions helping the researcher to stand back by
looking at quantitative summaries and charts.
Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo and Chapter 11 – Mapping
CHAPTER 11 discusses some of the varying principles, functions and rationales behind mapping tools where they are
available in software. Mapping in a graphic sense may relate to theoretical models or simply be a way of stepping back from
the data to express, visualize and communicate connections that are beginning to be observed.
Sections included in the chapter:
Traditions of mapping
Specific functions and specialities
Mapping to express theory
Expressing links between text passages
Visualizing co-occurring codes
Linking concepts
Layers, creating, hiding and revealing them
In NVivo the mapping tool is called the Modeler. (These exercises are largely complied using other sample data.)

11.1 MODELS – THE BASICS – MAKING THEM FROM SCRATCH
Models are another visual way to represent what is happening in your project or ideas you have about how various things
may be connected. Models are comprised of shapes and connectors which can represent project items, if desired. Models
are created by adding these shapes to a blank “sheet”. New models are created like any other new project item – from the
List pane, using the Project menu, or via the New button. (We’ll use the first method here.)


● In the Navigation pane, click on the Models section, and then click in the List pane. R-click and choose New
Model



OR in Explore Ribbon tab>New Model



In the New Model window, enter a name and (optionally) a description. When you click OK, a new blank
model is displayed in the Detail pane

Figure 11.1



You can add empty/abstract shapes click once on a shape in the Shapes palette on the left or R-click > New
Shape)



Or add project items R-click > Add Project Items – see Figure 11.2. below
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Figure 11.2



Add connectors from one shape or project item to another by clicking on the source object and then holding
Ctrl and clicking on the target object, and then R-click (on target object) > New Connector



Add names to abstract shapes that you have added by double clicking quickly to get the properties box up,
or double-clicking slowly to enter a label in the background - on them to go to their Properties (also accessible
by R-click)

11.2. EXPLORE CONNECTIONS
Explore connections
One way to utilize a Model is to explore the connections the project items in your Model have to each other by adding
Associated Data. To do this:
1. R-click on a project item of interest already in your Model
2. Choose ‘Add Associated Data…’
3.

Figure 11.3

3. The Add Associated Data box appears, asking you to choose any other items you want to see on the Model to
which the item is connected.


Note you can bring in new project items this way
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Or you can have NVivo display connections between items already in your Model



Or If you right click on any item in a model you can choose to add associated data

As you add project items, those already in the Model are greyed out in the Select window so you can’t add an item twice.
You can begin to see how the model allows you to look in on your project and progress from above – to see what
connections have been made – where the exceptions are. See illustration below. The community minded node is sitting in 4
files – but not in Mary or Grace – is there a reason for that? Does that need investigating?

The model above, for example, starts to give an idea of the different images that men and women interviewees have about
volunteers.

11.3 ADDITIONAL IDEAS FOR MODELS


Open any project item directly from a model by selecting it > R-click > Open Project Item.



Remove an object from the model by selecting the object > R-click > Delete
o

IMPORTANT: DO NOT Delete from Project!



Models are highly customizable. You can change the font of the labels, the fill color, etc. of all the shapes you
select - use the Home Ribbon tab to find editing options You can even use small images instead of shapes.
(Select the shape you want to transform into an image and go to Format > Fill > Image and browse for your
picture.) Project items are customizable, too, in terms of fill and color, but not in terms of shape



You can make a “mess” really quickly with a model depending on the amount of associated items you bring in
with a project item. Don’t be afraid to play with the model layout (Model > Layout) to see if that helps clean
things up. (And there’s always “Undo”!)



Remember that the distance of any one object from any other object means NOTHING. If you want items that
are closer to each other to mean they have a stronger association, that’s fine, but YOU need to set that up
manually



Zoom out – expand – models, more than anything else, may cause you to feel as though you’re running out
of “screen estate”. To get more room to work, try some of the following:
o

Undock the model (View Ribbon tab > Undock)

o

Zoom out to see more (View > Zoom)
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Groups (in the right palette) work like transparency layers. Create different groups to be able to show the
building of ideas within your model.
o

Select the items required – select Custom Groups tab in the palette, R-click in the palette to create
a new group

o

Add more items, shapes, and connectors to the group by selecting the relevant items and placing a
check in the left column on the palette under the large checkmark

o

Toggle the viewing of each group by (un)checking the right column under the eye icon

TIP: It may be easiest to make and arrange your final model first, and then work backward to create groups.
o

Interrogate by viewing the relevant Node Classifications (& attributes) tab in the palette– switch off
selections (particular values) in the right palette (under the RH column) to switch off the items
relevant to the selected attribute value (or to create a Custom group) – or switch back on

11.4. PRINT OR COPY A MODEL


File menu>Print will print any docked model in the detail pane



Any model can be copied (Ctrl-A > Ctrl-C) and then pasted into Microsoft Word or Microsoft PowerPoint for
viewing outside NVivo. Make sure everything is arranged where you want it before doing this, however, since
once outside NVivo, the model becomes a single layer image and none of the parts can be adjusted (nor can
individual project items be launched)

Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo and Chapter 12 – Organizing Data
Chapter 12 discusses the variety of ways organisation of data can happen and the importance of particular organizing tools
to enable different levels and complexity of interrogation. Chapter 6 discussed basic structures like folders which enable
simple tidying up and filtering. This chapter takes the subject further and focuses on the need to assign multiple variables or
attributes to each respondent or case, so that comparing within or across cases can happen via combinations of data and
subset characteristics if required.
Sections included in the chapter:
Illustrating the potential for interrogation
Timing, when to put organisational structures in place
Organising whole documents
Organising parts of documents
Auto coding structures in documents

12.1. EXPLAINING HOW DATA CAN BE ‘ORGANIZED’ BY FACTUAL OR SOCIODEMOGRAPHIC CHARACTERISTICS
This section only deals with the organisation of primary data – see a short section at the end which discusses the
organisation of e.g. literature
Organizing data using NVivo’s most efficient method for doing so is not the easiest process to absorb and get right. We all
the methods (and state their shortcomings if there are any, so that you can make the right choice for your data). Some of the
methods you may already be using. We strongly advise you to follow the logic of all the advice below in sequence.
Some questions first.
1. Do you have a very homogenous data set with not many differences in respondent type or socio demographic
characteristics are not relevant?
If the answer is YES you can ignore the more complex options for data organisation and possibly focus on the
simpler options.
2. Do you have too much information i.e. complex facts, features and information to keep in your head when it will
come to interrogating and comparing across and within different files and cases?
If the answer is YES, you probably need to make a choice from the more complex methods of data organisation
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12.1.1. SIMPLER METHODS OF DATA ORGANISATION
Folders or Sets

What they can do
You may already have organised you source files in folders – these can act as a filtering device when doing later Queries
‘Items in Selected Folder’ using the query tool – similarly Sets (if you have sources there) can acts as an ‘Selected item’ to
filter to.

Figure 12.1

What Folders and Sets can’t do
They can’t be combined to create more complex scoping for a query. Multiple folders cannot be searched ‘across’ - i.e. to
produce an easy cross tabulation matrix style output in one query. (Though you can do separate queries to build up a sense
of comparison).

12.1.2 MORE COMPLEX METHODS OF ORGANISATION
Creating nodes to represent and code respondents/cases/other units of analysis
If the answer to the second question above was YES and you do have a complex dataset with many socio-demographic or
other information to keep in mind about your respondents/cases then you need to create Nodes which act as structural
nodes representing for your individual respondents or the other units of analysis you are dealing with. Not all your files will
be about people. Sometimes nodes will be needed to represent observations, field notes, or material about studies or
places.
Once you have done this (however you do it see below at section 12.2) It enables several possibilities for you straightaway.
A. Where a file consists of more than one case you can use the code/node applied to each case to view just that case
(say one speaker from a focus group)
B. You can combine/copy/merge those case type nodes into another node based on a socio demographic characteristic
(and so on with other socio demographic values) female, male, OR female of 20-29yrs old etc. use this rather than the
below option only if you really do not understand option C. All your queries will use combinations of nodes codes rather
than any other entities of organisation (or combined with folders)
C. Use another entity the Node Classification = most efficient and INSTEAD OF POINT B. ABOVE, more difficult to
grasp but more efficient: Link the (structural) nodes e.g. for each respondent to a Node Classification (usually only one,
but depends on the spread of data and different elements of the research project). The Node Classification enables any
number of attributes to be created below it…and that is how socio demographics are assigned i.e. to each Node but via
its link the Node Classification . This is enabled via nodes representing and applied to all the data for each e.g. person or
case respectively. See Figure 12.1 below
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Figure 12.2

12.2. MAKING NODES TO REPRESENT RESPONDENTS, CASES ETC
Not all your files will be about people. Sometimes nodes will be needed to represent observations, field notes, or material
about studies or places.
a. BY HAND You can do this by normal coding methods by hand
b. IF FILES ARE ALREADY IMPORTED and represent one case or respondent – the software can do this quickly (see
below – section 12.3.)
c. MULTIPLE RESPONDENTS IN ONE FILE If you have multiple respondents in each file – you can do it by auto coding
(if you have the right structures in the files (see data preparation in Chapters 4 and 5) – see auto coding instructions
below. Or you code them by hand.
d. ON DATA IMPORT If files represent one case or respondent the software can create and apply a node as an
automatic task on data import ( if you choose the right options) but in this case you also need to have created a Node
classification up front see Section 12.3). NOTE: earlier instructions to import data were kept simple so we show you
below
how
to
do
this
retrospectively
below.

12.3

MAKING

NODES

RETROSPECTIVELY

FOR

FILES

ALREADY

IMPORTED – LINK THEM TO A NODE CLASSIFICATION
The summary of the process sequence
1. Make the node classification
2. Create one or two attributes under the classification (just to try it out)
3. Make a folder for the new structural nodes (case or respondent type nodes)
4.

Make the nodes

5. Link the nodes to the classification
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The full process
12.3.1. MAKE A NODE CLASSIFICATION
Be in the Classsifications function (see Navigation bar) Create/Node Classification see Figure 12.2. below.
TIP: you only need more than one classification if you really have different data for which VERY different
attributes are needed . Usually one will do and you can just have as many attributes underneath it as you
might require to organise all the different data.

Figure 12.2

NOTE: There are few advantages in using the predefined classifications in this case

12.3.2. CREATE ATTRIBUTES AND VALUES
To add Attributes to a Classification, first, locate the Classification in the List Pane. Then:


Figure 12.3

be any other name) and the ‘New Attribute’ dialogue box will open.
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Enter a name for your Attribute (e.g., “Gender”) and a description if relevant.



R-click on the name of the Classification (‘Interviewees’, in the picture here)



Select an Attribute Type from the menu (text, integer, etc.).



NOTE: Your choice of text versus an Integer (number)



Using a Number Type value is critical if you have an Attribute whose values are numerical and you intend to
query the data based on terms such as “greater than” or “less than”. NVivo recognizes that “3 > 2”, for
example, but does not know that “three > two”. Additionally, NVivo cannot order ranges (e.g., 20-29, 30-39)
because it recognizes them as textual, not numeric. If your data contains ranges you will want to order, it is
advisable to convert it to a number for purposes of the Attribute and Values. You may choose, for example, to
enter the range 20-29 as 25, 30-39 becomes 35, etc.

1.
2.
3.
4.

5.
6.

Figure 12.4



Click on the Value tab (shown left)



Enter relevant values using the ‘Add’ button. (Male and female, in this example). Each separate Value should
occupy one line in this table



Click ‘Ok’ when finished

12.3.3 MAKE A FOLDER FOR YOUR RESPONDENT /CASE NODES


Figure 12.4

Be in the Nodes function (see Navgiation ane) right click create new folder – call it CASE NODES or PEOPLE
NODES or RESPONDENTS (it doesn’t really matter what you call these entities like this Nodes folder or the
Classification – they are purely structural…as long as you understand what they are for (that’s the tricky bit!)
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Figure 12.5

12.3.4 CREATE NODES AND APPLY THEM
What sort of units of analysis have you got?
A Do your source files each represent one case/respondent?
B OR are there multiple cases/respondents in each file?

A Source files representing one case/respondent
See the Figure 12.6 as you follow these steps:
1. In the Sources List Pane, highlight all the Sources from which you want to make Respondent Nodes. (These could
be all the one-on-one interviews, for example.)
2. R-click over the selected Sources and choose Create As / Create As Case Nodes
3. In the Select Location dialogue, choose the Node folder into which you want the new Nodes to go (in this example,
‘Respondents’)
4. In the lower part of the dialogue, choose the appropriate Classification to which to assign the resultant Nodes (in
this example, ‘Interviewees’)
5. Click OK
6. If you’ve inadvertently skipped step 4: locate the Nodes you’ve just made in the Nodes folder, select them, right
click on top of them, and choose Classification

Figure 12.6
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7.

If you now find your Node Classification – right click and open it – there will now be a table that appears in the
detail pane, allowing you to assign values in relevant cells

8. Hover your cursor over a cell, click on the down arrow and either reveal the drop down of values you have already
made – or select the Unassigned value – and type a new value over it

Figure 12.7

B Are there multiple cases/respondents in each file?
You can choose to code the speaker sections by hand if you need to – or you can
Use the auto coding tool if you have identified and entered speakers or relevant sub-titles appropriately AND have formatted
correctly using consistent heading level styles– see Chapter 4-5

Autocoding for structure within Sources (e.g., speaker sections in focus group data)
With focus group data, you might want to autocode your data to compare responses of different participants. Similar to
autocoding individual interviews, make sure that you have properly formatted documents (ex., Heading 1 for topic area and
Heading 2 for speaker sections – or a another, different pair of heading levels will do) prior to autocoding. (If your data is not
properly formatted, remember that you can always code for speakers “manually”: create a Node for each speaker and, in
turn, find and code each contribution by each speaker.)

TO AUTOCODE


Go to Sources and click on the folder that contains the focus group documents



In the List Pane, select the documents for autocoding by holding Ctrl and left clicking



Go to the Analyze Tab and select ‘Autocode’. A window appears where you can specify your auto coding
criteria. As above, it is set to Paragraph Style



Choose the headings you want to auto code



Click Select to change the Location to Nodes\Respondents (this is the folder we created earlier)



Click OK
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1.

Figure 12.9

Figure 12.8



You can view all of each speaker’s contributions separately by double-clicking to open a speaker Node.
Additionally, now that you have a Node for respondents, you can link them to an appropriate Classification…



Select all the Nodes – right click / Classification> Choose relevant classification as below Interviewees

Figure 12.10



Apply relevant Attributes by following the process described above at section 12.3.4. and Figure 12.7. These
processes together enable interrogation of the data on the basis of Attributes or cross tabulation type queries
of codes by attributes

In Chapter 13, we follow up on what we have enabled here to discuss data interrogation and the discussion in the book
covers various special types of query – including Matrix codiing queries in NVivo. See Chapter 13 exercises.

12.4. ORGANIZING LITERATURE BY USING DOCUMENT CLASSIFICATIONS
Source classifications are designed by the developers of the software to be used to handle meta data for Literature files,.
They will be useful but this depends on the degree to which you use NVivo for that purpose. When you import a bibliographic
database – say from EndNote, you need to have already created a Source Classification to utlize that the meta data is
attached to attributes under the Source Classification. Our recommendation, use a general “ Reference” Classification rather
than a specific data-type specific classification. See predefined source classifications when choosing to create a new Source
Classification. Ann Lewins, Christina Silver and Jen Patashnick. 2014
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NVivo and Chapter 13 – Interrogating Data
Chapter 13 discusses interrogation of data that can happen at varied levels and at many moments during analysis. Already
in Chapter 6 we referred to Text search tools where the content is explored. Interrogation can also happen in terms of coding
work you have previously achieved. You might wish to discover relationships between codes which co-occur in some way in
the data or need to compare them across subsets of data (indicated by the application of variables or attributes to data).
Types of queries vary from simple to complicated tasks; summarized, charted information where the results are already
available in the background is available in some software.
Sections included in the chapter:
Incremental and iterative nature of queries
Creating signposts for further queries
Identify patterns and relationships
Qualitative cross tabulations
Quality control, improving interpretive process
Tables and matrices
Charts and graphs

INTRODUCTION TO QUERIES and CHARTS
It is not possible in this section to give you a full guide to the Query tool and charts as ways to interrogate data, but instead
will provide ways to get you started, detailing the most commonly used types of queries, providing general information
relevant in some way or other to all queries. Use the Query tool in simple ways to start until you are confident with it and
then you can increase the complexity of your queries. WE have already covered the use of Word Frequency and text

search queries in Chapter 6 sections.

13.1. FIND and QUERY – WHAT’S THE DIFFERENCE?
The Find tool is for finding project items which are characterized in certain ways. Outcomes from Finds can become Search
Folders (see Collections). The Query tool is for answering questions about the content of those items. Queries look for
source content with specified features – words in the text, coding, attributes of a case, or any combination of those, to be
built up with a range of logical (Boolean) and location operators. The Query tool offers more subtle ways of asking questions;
more complex ways of viewing, saving, and using results; and the ability to save a query so you can re-run it through
different data or later on without reconstructing it. Outcomes of each: where Find gives you a list of project items as an
answer, Queries provide the actual content requested and new nodes can be created from the results.

13.2. INITIATING QUERIES – GENERALLY
NVivo 10 allows you to construct seven different types of queries – text search, word frequency, coding, matrix coding,
compound, coding comparison and Group.
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We

cover

Coding

Queries

and

Matrix

Coding

queries

in

some

detail

below

–

Other queries include: Coding Comparison, useful for teams produces a Coder Inter-agreement measured with Cohen’s
Kappa and can be useful to find similarities, differences and interesting findings for further analysis. The Compound Query
allows you to create a combined text search and coding query, the Group query – allows you to select for instance pairs of
documents to compare coding.


Create a new query in the Query Ribbon tab/ new query> select type of query – see 7 basic types of query
(not counting the Advanced Find)

Figure 13.1



OR…
If
you
are
already
pane> new query> select type of query



When you choose to make a new query, the new query window always includes an option to Add to Project,
which, when checked will add an additional tab (General) to the existing ones. TIP: It is strongly suggested
you get in the habit of always adding your query to the project (e.g., saving it) so that you can rerun it later if
needed, or adjust it without having to build the entire query again. In general, new queries have at least three
tabs – General, Search Criteria, and Query Options

in

the

Queries

Folder

R-click

in

the

List

Figure 13.2



The General tab allows you name the Query as you wish to see it in the List (having checked Add to Project
in previous pane) There’s also a description box where you can describe what the query is, or, write the
question you’re asking in “plain English”. This can be useful in case you get confused as you create the query
about what you were trying to find out in the first place!



The Search Criteria tab is where you will put the operators and operands for whatever search you’re running.
What exactly goes here will vary significantly based on the type of query you’re running. See below for
examples of many of these
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Figure 13.3



The Query Options tab is where you will tell NVivo what you want to do with the Results of your query. The
options will vary depending on the query type



You can choose how you want the results to appear and where you want them to be saved



You can add a description to the results (if they will be saved as a set or a node).



Lastly, you can choose to Spread Coding and if so, to what units. (Reasons for and against will be discussed
with the relevant queries below.)



Note that hitting Run will both Run the query and save the query and results. Hitting OK will save the query as
currently set up but not run it to get results. Cancel will simply close the window without saving anything

NOTE: There are limitless ways of performing these queries, depending on the items and the operators used.
We can only show two examples. but given that the General and Query Results tabs are pretty much the same
for each, the screenshots below are of the relevant Search Criteria tab only.

13.3. SCOPING THE QUERIES
Remember that all queries can be scoped to one or several selected files, a folder of files a Set of files or all sources
(default). This can take place in the In bar of every query. Instead of agreeing to All Sources – use Selected items or
Selected Folders.

Figure 13.4
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13.4. CODING QUERIES
Coding queries are probably the most frequently run query for most researchers. This query is very customizable and allows
you infinite ways to examine how various codes have been used in your project. For this reason we only provide two sample
queries – and several possible ways to vary outcomes.
CAUTION: none of the entire range of Coding queries work with Source Classifications and attributes – for
this reason you hopefully used Node Classifications to get organised, i.e. using Node Classifications.
TIP: get into the habit of Adding to project (top left) to name and save the query – this saves the settings, i.e.
the way you built the query – so that later you can re-run it or change the settings (but only temporarily) to
experiment.


In Explore ribbon tab – choose new Query/Coding query

There are two important tabs in the dialogue box – Simple and Advanced.
Simple means you can only ask for data coded by one node or by one attribute value – though you can add a second
dimension by varying the scope (from All Sources, to Selected items or Selected folders).
Advanced means you can combine several different items in various ways (see below).

13.4.1 SIMPLE CODING QUERY


Even if you are only going to do a Simple query – Add to project - In the example below a prefix has been
used to name the query CQ-financially secure (later it helps to be able identify the broad category of the query
you are reviewing, in the name itself)



Having named the query – choose Coding Criteria tab

Figure 13.5



EITHER at button for > Node / Select the node (thematic?) you want to examine (as shown in the example
below OR at button for >Any node where (this is asking for Node Classification attribute value) – you can only
choose one of these in a Simple Query



You can add another dimension by scoping (or filtering) the query –see Figure 13.4

So…instead of running the query.
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In …All Sources click on drop down arrow to either


Select items (i.e.select particular documents, Sets, or Nodes (i.e. only in data coded by another node) Or…
Select Folders i.e. folders containing sources



Finally – in any query you can vary how you deal with the outcomes in the Query Options tab – these options
vary
depending
on
the
type
of
query
being
performed
– most of these options are self explanatory – but in case it is not clear – Create results as New Set –
means that a Set of source files (shortcuts to actual documents) in which finds occurred satisfying the terms
of the query, is created. Find the Set in the Collections function

Figure 13.6

13.4.2. ADVANCED CODING QUERY
In general, it is probably more common to use the Advanced tab since that allows more user flexibility. In this example
(below), we have chosen to set up a query to determine what sections of source content have been coded to both the
“Motivation” and the “Financially secure” nodes.


Choose the Advanced tab – then Add to Project –in this example we are looking for the physical
intersection or co-occurrence (AND) of two nodes



As soon as you choose the Advanced tab it knows you are going to select several items so – after selecting
the first option an Add to List button will appear – if you do not hit this button after a selection, nothing will
happen.



Note also, that an AND has appeared at the Define more Criteria bar. Choose the node(s) in which you’re
interested on the second bar
Figure 13.7
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Then hit Add to List button. AND means the togetherness or intersection of items in the data. If you accept
this – and then select the second node (or any subsequent nodes-also on an AND basis) then the query will
be performed finding only data where all the codes /nodes in this query, intersect



Further versions of the same query could add attribute values (again on the AND basis) - and then
additionally – vary the All Selected Nodes bar by clicking on the down arrow to choose Any Node where Select Node Classification attributes and check the value of the attribute you want to add to the query criteria



Get more complex by working incrementally - thus by employing different Boolean operators (see under
the AND option) you can continue to narrow the focus of queries – or save relatively simple results at nodes
and incrementally use the resultant nodes in further queries.



OR..you can again be incremental by saving the results at a Node and building that node into new queries



There are Boolean (AND, OR, NOT) operators and also Proximity operators

TIP: Experiment with queries you know the answer to in order to check that you are building queries correctly!

13.5. OVERVIEW OF MATRIX CODING QUERY
A matrix coding query is as if you were running multiple coding queries at once – usually you will be setting out to achieve
one of several options:


Comparing a selection of thematic nodes (or just one) across several attribute values



Comparing a selection of thematic nodes (or just one) across e.g. Documents or Source Classification
attributes



Looking at how several nodes (or just one) co-occur (‘AND’), with other nodes. Other operators include ‘OR’ ,
‘NOT’, ‘ PRECEDING’ ‘NEAR’ ‘SURROUNDING’ other nodes

The result will be a table where each cell represents the answer to a single query of the row and column – the initial view will
be based on frequency – this can be varied – can be counting how many sources feature at all at a node, or number of
coded passages (references), or number of words coded, or varied percentages etc. Each cell can be ‘opened’ to reveal
relevant qualitative content. If the results of query is saved, you can return to the snapshot of the find over and over again. If
you Save the ‘query’ i.e. Add to project you can re-run the query over and over again by double clicking on it.









Figure 13.8

The results table of a matrix query will have Multiple cells. What type of frequency or shading shown in the
cells - can be changed by right clicking in the table
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MOST IMPORTANT! Double clicking any one cell will open the results of that one e.g. co-occurrence, in the
Detail pane. From there the qualitative data can be copied from any cell, meaning that this matrix query result
can be used as a resource to come back to again and again when writing up



EQUALLY IMPORTANT! Be sceptical about the numbers in the matrix – your qualitative sample is probably
not designed to produce statistical significance. The numbers reflect personal interpretations and more
importantly personal style of coding (big chunks coded or small chunks?) – it is the qualitative data behind
each cell that s important – and that itself will be dependant on the thoroughness and consistency of your
coding.
● Every matrix produces a rotatable 3D chart – view the chart from the side tables of the detail pane in which
the result sits

13.1. Charting
This is all about standing back from the data while interrogating (see above after the results of a matrix coding query). A
visual, but potentially quantitative look at who much coding has been applied in various places in your data. Charts can be
created to show a variety of different things:


See how coding in a source is broken down proportionately in that source



See how coding is broken down proportionately across sources



See how cases are broken down by attribute



The results of a matrix query in 3D
o

The quickest and easiest way to create a chart is to e.g. R-click on whatever it is in the List pane
that you’re interested in charting> Visualize> Chart Document Coding . OR as below, right click on
a code (here the code Wellbeing) Visualize> Chart coding for Node

Figure 13.8

o

You can also generate a chart by going Explore Ribbon tab / Charts. This way will launch the Chart
Wizard where you can choose what you’re seeing in a step-by-step fashion

Some additional thoughts on charts:


Charts are very easy to use – but are limited



Charts are useful - a good way of checking sample distribution or breakdown (an attribute by cases), for
example



Publishers will love them; researchers who think qualitative research is, at its heart, about numbers will love
them



Researchers who really need to integrate quantitative reporting with qualitative data will love them



BUT… charts are nearly always about a quantitative breakdown of your project in some way or another. Use
them, profit (in terms of guidance and pointers) from them, but, as with all the quantitative breakdowns in
software, be cautious and aware of what they are actually telling you
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13.2. Cluster Analysis
Cluster analyses allow a particular quantitative approach to the measurement and various visualisations of the relative
associations of e.g. codes with other codes on the basis of word similarity or proximity.

Different formats of Cluster Analysis

Figure 13.9

Similar to charting – use Explore ribbon tab/Cluster Analysis to begin the process of building tree maps or cluster analyses –
see the NVivo online Help? menu for more information on Cluster Analysis and Visualisation tools.

Figure 13.10

Here, nodes are clustered by their level of similarity of word usage . Or you can display sources similarly clustered by word
usage similarity.

13.4 Concluding remarks
Since Charts and Queries are always produced at a point in time, remember that there is a purpose in saving snapshots of
the results – but also
With queries, the results are snapshots if you save them under Query Options.
The Query itself is dynamic (if you use Add to Project button) since you can re-run it
With Charts they are correct at a point in time – you can export them (as a graphic) in order to be able to track back or retain
information at different stages of work at this level.
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